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AHGW Pro 1.0 Tutorial 

Subsurface Analyst – Creating ArcGIS Pro Cross 
Sections from Existing Cross Section Images 
Add images and update cross sections using images in ArcGIS Pro 

 
 

Objectives  

Learn how to use Arc Hydro Groundwater Pro tools to add images to cross sections. 

 

Prerequisite Tutorials 

 Subsurface Analyst – 
Creating 2D Cross Sections 

Required Components 

 ArcGIS Pro 

 3D Analyst 

 Subsurface Analyst 

Time 

 25–45 minutes 

 

AHGW Pro 1.0 
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1 Introduction 

Arc Hydro Groundwater Pro (AHGW Pro) is a geodatabase design for representing 
groundwater datasets within ArcGIS Pro. The data model helps to archive, display, and 
analyze multidimensional groundwater data. It includes several components to represent 
different types of datasets such as representations of aquifers and wells/boreholes, 3D 
hydrogeologic models, temporal information, and data from simulation models. The Arc 
Hydro Groundwater Pro Tools help to import, edit, and manage groundwater data stored 
in an AHGW Pro geodatabase. Subsurface Analyst is a subset of the AHGW Pro Tools 
that is used to manage 2D and 3D hydrogeologic data, and create subsurface models 
including generation of borehole representations, cross sections, surfaces, and volumes.  

This tutorial will demonstrate how to add images to cross sections. Adding cross sections 
from reports may be useful for a number of purposes: 

 Adding “legacy” knowledge to cross sections. Existing cross sections from 
reports/papers/map books with new information (boreholes, rasters, faults, etc.) 
can be combined to create new cross sections or update the old ones. 

 Inclusion of data in existing cross sections from papers/reports/map books in the 
development of 3D hydrogeologic models. 

 Archiving cross sections in a systematic way inside a geodatabase. 

Subsurface Analyst includes tools for creating 2D cross sections by adding data to a new 
XS2D data frame and “sketching” cross sections based on borehole stratigraphy, 
outcrops, faults, etc. In addition Subsurface Analyst supports the creation of 3D cross 
sections and volumes from a set of surfaces. The 2D and 3D features can be viewed in 
ArcGIS Pro. The workflow and tools for creating 2D cross sections and 3D features are 
described in separate tutorial.  

1.1 Background 

Data used in this tutorial are part of a USGS report describing the hydrogeologic units of 
the Coastal Plain in Virginia (http://pubs.usgs.gov/pp/2006/1731/). The cross sections 
shown in       Figure 1 were digitized from the report. 

http://pubs.usgs.gov/pp/2006/1731/
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      Figure 1      Location of the cross sections covering the Coastal Plain in Virginia 

The cross section lines shown in the map are related with a vertical cross section 
describing hydrogeologic units in the Coastal Plain Aquifer system. The vertical cross 
sections are detailed in a set of PDF files.       Figure 2 shows an example of such a cross 
section. The solid colors represent aquifers and the white colors in between represent 
confining units.  

   

       Figure 2      Example cross section showing hydrogeologic units along a cross section  

1.2 Outline 

The objective of this tutorial is to introduce the basic workflow and tools for adding 
existing 2D cross sections (in the form of images) to a XS2D data frame in ArcGIS Pro. 
The tutorial includes the following steps: 

1. Running the Import XS2D Image Wizard to create a new XS2D data frame and 
corresponding feature classes and georeference the cross section image in the 
XS2D data frame. 

2. Digitizing XS2D panels based on the image. 

3. Building 3D GeoSections from the panels and visualize in ArcScene. 

1.3 Required Modules/Interfaces 

The following components should be enabled in order to complete this tutorial: 
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 ArcGIS Pro license 

 3D Analyst 

 Arc Hydro Groundwater Pro Tools 

 AHGW Pro Tutorial Files 

The AHGW Pro Tools require that you have a compatible ArcGIS Pro service pack 
installed. If needed, check the AHGW Pro Tools documentation to find the appropriate 
service pack for the version of the tools. 3D Analyst is required for the last section of the 
tutorial for visualizing 3D features. If 3D Analyst is not available, skip these parts of the 
tutorial. The tutorial files should be downloaded to the computer. 

2 Getting Started 

Begin by opening a project containing some background data. 

1. If necessary, launch ArcGIS Pro. 

2. If on the ArcGIS Pro start page, select  Open another project in the bottom 
right corner of the window to open the Open Project dialog. 

3. If already in the user interface, use the  Open macro to open the Open Project 
dialog. 

4.  Browse to the location with tutorial files for this tutorial. 

5. Select the file “xs2d_image.aprx” located in the 
SubsurfaceAnalystPro/XS2D_Image folder. 

6. Click OK to import the project. 

Once the file has loaded, there should appear a map of Virginia with digitized cross 
section lines covering the Coastal Plain region (      Figure 3). In a separate “images” 
folder there is a PDF document taken from the USGS report. There also are two JPG 
images representing cross sections AD-AD’ and BD-BD’ that were cropped from the PDF 
document. View these files to get familiar with the cross section images. Locate these 
cross sections on the map.  

 

      Figure 3      Starting project 

The following section describes the concepts and datasets used to build a XS2D data 
frame. The same concepts are presented in other XS2D tutorials; if familiar with this 
material skip section 3. 



AHGW Pro Tutorials  Adding Images to Cross Sections 

 Page 5 of 16 © Aquaveo 2023 

Before continuing, ensure that the AHGW Pro tools are correctly configured. 

1. In the Catalog pane, expand the  Toolboxes folder. 

The ArcHydroGroundwater.pyt toolbox should appear under the list of toolboxes. If 
toolbox is not visible, complete the following:  

2. In the Catalog pane, right-click on  Toolboxes and use the  Add Toolbox 
command to open the Add Toolbox dialog. 

3. Browse to the location of  C:\Program Files\Aquaveo\ 
AHGW_ArcGIS_Pro_Python_Toolbox directory and select and open the 
ArcHydroGroundwater.pyt file. 

4. Click OK to close the Add Toolbox dialog. 

With the ArcHydroGroundwater.pyt toolbox available, access the Groundwater Analyst 
tool. 

5. Expand “  ArcHydroGroundwater.pyt”. 

6. Expand “  Groundwater Analyst”. 

When using geoprocessing tools, it’s possible to set the tools to overwrite outputs by 
default, and automatically add results to the map/scene. To set these options: 

7. At the top of the ArcGIS Pro window, select the Project tab. From the list on the 
left, select Options to open the Options dialog. 

8. Select Geoprocessing from the list under Application on the left of the dialog. 

9. Ensure that Allow geoprocessing tools to overwrite existing datasets and Add 
output datasets to an open map are turned on. 

10. Select OK to exit the Options dialog. 

11. Using the arrow in the upper left corner, return to the main screen. 

3 Representing 2D Cross Sections in the AHGW Pro Data Model 

Before starting to create cross sections, it is helpful to review the component of the 
AHGW Pro Data Model. The AHGW Pro Data Model includes a number of components 
used for different purposes. The hydrostratigraphy component includes data structures 
for representing 2D and 3D hydrostratigraphy, including the creation of 2D cross sections 
(      Figure 4).  

SectionLine is the central feature class used to manage cross sections. Each SectionLine 
represents a cross section in map view. SectionLine features are indexed with a HydroID, 
which uniquely identifies them within the geodatabase. To create a vertical (profile) view 
of the cross section along the SectionLine, each SectionLine feature is associated with 
multiple feature classes representing the two-dimensional cross section, and these are 
given the “XS2D” prefix.  

Common XS2D feature classes are: 

 XS2D_Panel – polygon features representing cross section “panels”. 

 XS2D_BoreLine – vertical lines representing hydrostratigraphy along selected 
boreholes adjacent to the SectionLine. 

 XS2D_PanelDivider – vertical guides showing the location where a SectionLine 
changes direction. 
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 XS2D_MajorGrid and XS2D_MinorGrid – grid lines showing the vertical and 
horizontal scales in an XS2D data frame. 

Additional feature classes can be added to represent items such as land surface 
elevation, water table, faults, etc.  

 

      Figure 4      Datasets used for creating 2D cross sections 

Each of the 2D cross sections is generated in a separate data frame in ArcGIS Pro. The 
XS2D feature classes are created in an {S, Z} coordinate system that is unique for each 
cross section. The S coordinate represents the length along the SectionLine (equivalent 
to the x-direction in the XS2D data frame) and the Z coordinate represents the vertical 
dimension (the y-direction in the XS2D data frame). In addition, XS2D features can be 
scaled (exaggerated) in the Z dimension for better visualization. Subsurface Analyst 
includes a number of tools for transforming features between a “real” coordinate system 
(X, Y, and Z) and a 2D coordinate system (S, Z), and for scaling features. 

The XS2D_Catalog table is used for managing XS2D feature classes. The Catalog lists 
the XS2D feature classes related with each SectionLine feature. The SectionID field in 
the XS2D_Catalog references a HydroID of a SectionLine feature, thus creating a 
relationship between SectionLines (defined in real world coordinates) and XS2D feature 
classes. An example of a typical XS2D_Catalog table is shown in       Figure 5. 
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      Figure 5      Example XS2D_Catalog used for managing XS2D feature classes and establishing 
a relationship between the XS2D features and a SectionLine feature 

4 Adding Borehole Images to Cross Sections 

The XS2D Cross Section Image tool creates a new set of feature classes for representing 
a 2D cross section based on a specific SectionLine feature. The tool creates a new data 
frame to which the XS2D feature classes (XS2D_Panel, XS2D_PanelDivider, 
XS2D_MajorGrid, and XS2D_MinorGrid) are added. In addition, the tool georeferences a 
selected image so it can be displayed in the XS2D data frame. 

The tool is based on a selected section line (run the tool one cross section at a time). In 
this tutorial, a SectionLine feature class is already provided. To use the XS2D Cross 
Section Image tool: 

1. On the ribbon, select the Arc Hydro Groundwater Toolbar tab. 

2. Select 2D Cross Section Image   tool to open the XS2D Cross Section Image 
pane. 

3. Using the Select  tool located in the SelectLine section, click on BD-BD’ 
SectionLine feature (topmost horizontal section line that crosses the bay).  

4. For the XS2D Catalog Table option, make sure “XS2D_Catalog” is selected. 

5. Make sure the Default output workspace is selecting “xs2d_image.gdb\Data” 
directory. 

6. In the Image File section, select the browse  button to open the Choose XS2D 
Image dialog. 

7. Locate and select the field “BD-BD’.jpg” in the Images folder for this tutorial. 

8. Select OK to close the Choose XS2D Image dialog and open the XS2D Image 
dialog. 

The XS2D Image dialog is used to reference the imported image. If needed, resize the 
window to make it easier to view the cross section. 

9. Use the sliders on the top, bottom, left, and right to move the referencing lines (in 
green and red) to the referencing locations on the image: 

 XLeft and XRight referencing lines should be located on the edge of the 

cross section features. 

 ZTop and ZBottom lines can be referenced to the vertical scale and tick 

marks on the left and right sides of the cross section. 

 Specify the ZTop as “300” and ZBottom as “-1300” in the boxes at the bottom 

of the form. 

At this point the inputs should be similar to the ones shown in Figure 6. 
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Figure 6      Settings for Step 2 in the Import XS2D Image Wizard 

10. When done click Finish to exit the XS2D Image dialog. 

The XS2D Cross Section Image pane is used to create panels and panel dividers. The 
minimum and maximum elevations for drawing panel dividers can be modified manually. 

11. In the Panel Divider Elevation section, specify the maximum and minimum 
elevations to draw panel dividers: 

 Minimum set to “-2000”. 
 Maximum set to “600”. 

The XS2D Cross Section Image pane is also used to setup the construction of the grid 
lines. The grid extent and spacing can be automatically specified based on the length of 
the selected SectionLine and elevations, or they can be set manually. Default values are 
set for the left, right, minimum and maximum elevations, and spacing of the grid features.  

12. In the Grid Extent section, specify the following for the grid extent: 

 Top set to “600”. 

 Bottom set to “-2,000”. 

 Left set to “-100,000”. 

 Right set to “2,000,000”.  

13. In the Grid Spacing section, specify the following for the grid spacing: 
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 Distance between major grid lines Horizontal set to “200,000”. 

 Distance between major grid line Vertical to “200”. 

 Number of minor grid lines Vertical to “3”.  

 Number of minor grid lines Horizontal to “1”. 

14. Select Create XS2D Data to run the tool. 

A new “  Section BD-BD’” data frame should be added to the map (make sure to be in 
layout view to be able to view data frames). The grid lines, the panel dividers, and the 
referenced cross section image should all be visible. 

Next to resize the BD-BD’ data frame and move it within the map layout such that both 
data frames are visible. To better view the XS2D features created: 

15. Using the Explore  tool, move the BD-BD’ data frame within the map layout 
and resize it. 

16. Use the zoom tools ( ) to focus on the data within the cross 
section. 

At the end of this process there should be a cross section data frame that is similar to the 
one shown in Figure 7. 

 

Figure 7      Initial XS2D data frame with the referenced cross section image 

This is a good starting point for digitizing cross section panels by tracing over the image. 
Additional data such as faults, borehole stratigraphy, outcrops, land surface, and water 
levels could also be added using the XS2D tools (the process of adding data to a XS2D 
data frame is explained in separate tutorials). The following legend in Figure 8 shows the 
major units described in the cross section.  



AHGW Pro Tutorials  Adding Images to Cross Sections 

 Page 10 of 16 © Aquaveo 2023 

 

Figure 8      Aquifer units and confining layers in the Coastal Plain Aquifer system. Confining units 
are symbolized in cross sections as white panels and their boundary is defined by a 
dashed line. 

5 Sketching Cross Section Panels 

In this section, new cross section panels will be sketch. It will use the referenced image 
and utilize the advanced editing capabilities available in ArcGIS Pro.   

5.1 Creating a New Template for Editing XS2D Panel Features 

The first steps will be to set the editing environment: 

1. In the Contents pane, right-click on “XS2D_Panel_2” and select Symbology to 
open the Symbology pane. 

2. Click the menu button  and select Import Symbology… to open the Apply 
Symbology From Layer pane. 

3. For the Symbology Layer, select the browser button to open Symbology Layer 
dialog. 
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4. Browse to the Symbology folder for this project and select the “XS2D_Panel.lyr” 
file. 

5. Click OK to close Symbology Layer dialog. 

6. Click Run to execute the tool. 

The symbology for the XS2D_Panel_2 feature class should now appear in the Contents 
pane, as shown in Figure 9. 

 

Figure 9      The Create Feature window with a template for XS2D Panel features  

In the next section, set the snapping environment. 

5.2 Setting the Snapping Environment Options 

1. On the ribbon, select the Edit tab again. 

2. In the Snapping section of the Edit tab on the ribbon, select the down arrow 
under Snapping to open up a menu. 

3. Select the Snapping  icon to turn snapping on. 

5.3 Sketching Panels 

First, sketch the upper surficial aquifer unit:  

1. Zoom to the right end of the cross section and zoom in on the outcrop 
representing HGUID = 1 (Alluvium). 

2. Select Edit tab in the ribbon. 

3. In the Features group, click the Create  button to open the Create Features 
pane. 

4. In the Create Features pane, under “XS2D_Panel_2” template, select the feature 
symbology for HGUID = 1. 

Notice that in the Construction Tools window, a list of the available tools appears for use 
in creating new panels (Figure 10). 
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Figure 10      Construction tools available for sketching XS2D Panels 

5. Make sure the Polygon  tool is selected.   

Tip: while digitizing, use the zoom and pan tools to focus on certain elements of 
the cross section. Use the mouse wheel scrolling to zoom (or the Z and X keys) 
or hold down the mouse wheel (or C key) for panning. 

6. Using the Line  tool, start tracing the panel of HGUID = 1. Make sure to snap 
to the panel dividers on the right and left sides of the cross section.  

7. Double-click on the starting point to close the panel. 

The sketch should be similar to the one shown in Figure 11. 

 

Figure 11      Sketch of the surficial aquifer (HGUID = 1. 

After digitizing panels, edit attributes. The HGUID values should be automatically 
assigned from the feature template created earlier. The HGUID values are based on a 
HydrogeologicUnit table.  

8. Using the Select  tool, select the feature which was just created.  

9. Right-click and select Attributes to open the Attributes pane. 

10. In the Attributes window make sure a value of “1” is in the HGUID field. This 
value should be created automatically as you are using a template for editing. 

11. In the Edit tab of the ribbon, select Save Edits . 

Next, digitize the panel for the Yorktown confining unit (HGUID = 2): 

12. Zoom to the right side of the cross section.  

13. In the Create Features window, under “XS2D_Panel_2” template, select the 
feature symbology for HGUID = 2 
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14. Select the Autocomplete Polygon  tool, as shown in Figure 12. 

 

Figure 12      Selecting the Autocomplete Polygon Task in the Construction Tools window 

Now to begin sketching the Yorktown confining unit (symbolized as the white area 
between the yellow and pink units in the cross section image) by sketching from the 
bottom right corner of the surficial aquifer panel. 

15. Using the Line  tool, sketch the panel of HGUID = 2. Start at the bottom right 
corner of the surficial aquifer panel and make sure the sketch snapped to the 
panel corner. Sketch along the upper boundary of the Yorktown aquifer unit 
(symbolized in pink in the cross section image) until the point where the confining 
unit interests the surficial aquifer panel, as shown in Figure 13. Make sure to 
snap to the surficial aquifer panel edge. 

 

Figure 13      Sketching the Yorktown confining unit 

16. Double-click on the starting point to close the panel. 

A new polygon representing HGUID = 2 should be created. The polygon’s upper 
boundary should match the boundary of the polygon representing HGUID = 1.  

The sketch should be similar to the one shown in Figure 14.  

 

Figure 14     Cross section panel of the Yorktown confining unit (HGUID = 2) created using the 
Autocomplete Polygon task 

17. Using the Select  tool, select the feature which was just created.  
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18. Right-click and select Attributes to open the Attributes pane. 

19. In the Attributes pane, make sure a value of “2” is in the HGUID field. This value 
should be created automatically as you are using a template for editing. 

20. In the Edit tab of the ribbon, select Save Edits . 

Notice that the Yorktown confining unit (HGUID = 2) is composed of a number of 
polygons.  

21. Repeat steps 12–20 to create more panels representing the Yorktown confining 
unit.  

At the end of this process, the cross section should have panel representations for units 1 
and 2 as shown in Figure 15. 

 

Figure 15      Panel features representing units 1 and 2 

If desired, repeat this process to digitize the rest of the hydrogeologic units, or, to save 
time, use a set of predefined panels.  

1. Select Add Data  to open the Add Data dialog. 

2. Locate and select the “XS2D_Panel_2_solution” file in the xs2d_image.gdb\data 
directory. 

3. Click OK to close the Add Dialog and import the solution. 

4. Follow the steps in Section 5.1 to adjust the symbology of the layer. 

At the end of this process you will have a set of panels representing the units from the 
referenced image, as shown in Figure 16. 
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Figure 16      XS2D panel features representing units in a cross section 

6 Transforming 2D Cross Section to 3D GeoSections 

Once the 2D cross sections are created, it is possible to transform them to 3D features 
(GeoSections) and visualize them in ArcGIS Pro. This part of the tutorial requires 3D 
Analyst. 

First, create the GeoSection feature class: 

1. Switch to the “  Map” view 

2. In the Catalog pane, expand the “  Subsurface Analyst/Features” toolset, 

double-click on “   Create GeoSection Feature Class” tool to open the Create 
GeoSection Feature Class pane. 

3. In the Output GeoSection Features field, click the browse  button to open the 
Output GeoSection Features dialog. 

4. Browse to the xs2d_image.mdb\Data directory and enter “GeoSection” as the 
feature class name. 

5. Click Save to close the Output GeoSection Features dialog. 

6. Select Run to execute the tool. 

Next, create the GeoSection features by transforming 2D panels to 3D GeoSections: 

7. In the Catalog pane, expand the “  Subsurface Analyst/XS2D Editor” toolset 

then double-click on “   Transform XS2D Panel to GeoSection” tool to open the 
Transform XS2D Panel to GeoSection pane 

8. For Input Section Line Features select “SectionLine”. 

9. For Input XS2D_Catalog Table select “XS2D_Catalog”. 

10. For Input GeoSection Features select “GeoSection”. 

11. Select Run to execute the tool. 

Do the following to visualize the 3D GeoSections just created. 

12. Switch to the “  Scene” map view. 
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13. Select Add Data  to open the Add Data dialog. 

14. Browse to and open the “xs2d_image.gdb” geodatabase and open the “Data” 
directory. 

15. Select the “GeoSection” file and click OK to import the table and close the Add 
Data dialog. 

16. If desired, symbolize the GeoSection layer using the HGU Color Manager.  

The scene should be similar to the one shown in Figure 17. 

 

Figure 17      Scene including the GeoSection features transformed from the 2D cross section 

If desired, the complete set of GeoSection features that were created for the BD-BD’ 
cross section can be added. The features are in the “GeoSection_Solution” feature class 
located in the xs2d_image.mdb\Data feature dataset. 

7 Conclusion 

This concludes the tutorial. Here are some of the key concepts in this tutorial: 

 The Arc Hydro Groundwater data model includes XS2D feature classes that 
provide the framework for working with 2D cross sections in ArcGIS Pro. 

 The Import XS2D Image Wizard is used to reference an existing cross section 
image, set up a new data frame, and create the basic XS2D feature classes. 

 ArcGIS Pro editing tools are used to help digitize cross sections based on the 
referenced image. 

 2D cross section panels can be transformed to 3D features and visualized in 
ArcGIS Pro. 

 


